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Chapter 2
Operators

This chapter lists and describes Mathcad’s built-in operators. The operators are 
according to the toolbar (Arithmetic, Matrix, Calculus, Evaluation and Boolean, o
Programming) on which they appear. 

Operators labeled Professional are available only in Mathcad Professional.

Accessing Operators
You can access operators in two ways:

• Simply type in the keystroke shown for that operator, or

• Select the operator from a toolbar.

1. First, select View ⇒ Toolbars ⇒ Math . 
The Math toolbar appears showing the various operator toolbar buttons.

2. Click a button for a specific toolbar. The corresponding toolbar appears.

You can alternatively go directly to an operator toolbar from the View me
by selecting View ⇒ Toolbars, and then selecting one of the operator toolba
listed; for example Matrix :

Arithmetic

Calculus

Greek Letters

Evaluation and Boolean

Matrix and Vector

Programming
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The Matrix operator toolbar appears, showing the various matrix operato
buttons:

3. Click the button of the operator that you want to use.

Finding More Information
Refer to the Resource Center QuickSheets for examples involving operators. Se
Resource Center from the Help menu. Then click on the QuickSheets icon and sele
a specific topic.

About the References
References are provided in Appendix B for you to learn more about the numerica
algorithm underlying a given Mathcad function or operator. References are not inte
to give a description of the actual underlying source code.  Some references (su
Numerical Recipes) do contain actual C code for the algorithms discussed therein,
the use of the reference does not necessarily imply that the code is what is implem
in Mathcad.  The references are cited for their textbook nature only.
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Arithmetic Operators
To access an arithmetic operator:

• type its keystroke, or 

• choose the operator from the Arithmetic toolbar (if it has a button):

Refer to “Accessing Operators” on page 135 for more information on how to acce
toolbar.

Parentheses

Keystroke ' Toolbar Button

Description Groups parts of an expression.

Addition  

Keystroke + Toolbar Button

Description If X and Y are real or complex numbers, adds X and Y. 
If X and Y are real or complex vectors or matrices of the same size,  adds elements of X to 
corresponding elements of Y. 
If X is a real or complex array and Y is a real or complex number, adds Y to each element of X.

Addition with line break  

Keystroke [Ctrl][ ↵]

Description Adds in the same manner as Addition, but inserts a line break for cosmetic formatting reason

Comments This formatting feature cannot be used for multiplication or division. It can be used with 
subtraction if X − Y is written instead as X + (− Y).

 X ( )

X Y+

X…
Y+
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Subtraction and Negation , 

Keystroke - Toolbar Button

Subtraction
Description If X and Y are real or complex numbers, subtracts Y from X. 

If X and Y are real or complex vectors or matrices of the same size,  subtracts elements of Y from 
corresponding elements of X. 
If X is an real or complex array and Y is a real or complex number, subtracts Y from each element 
of X.

Negation
Description If X is a real or complex number, reverses the sign of X.

If X is an real or complex array, reverses the sign of each element of X.

Multiplication  

Keystroke * Toolbar Button

Description If X and Y are real or complex numbers, multiplies Y by X. 
If Y is a real or complex array and X is a real or complex number, multiplies each element 
of Y by X. 
If X and Y are real or complex vectors of the same size, returns the dot product (inner prod
If X and Y are real or complex conformable matrices, performs matrix multiplication.

Division

Keystroke / Toolbar Button

Description If X and z are real or complex numbers and z is nonzero, divides X by z. 
If X is an real or complex array and z is a nonzero real or complex number, divides each elem
of X by z.

Range variable

Keystroke ; Toolbar Button

Description Specifies that a variable assume a range of values (for the sake of repeated or iterative 
calculations).

Factorial
Keystroke ! Toolbar Button

Description Returns  if n is an integer and ; 1 if n = 0.

X Y– X–

X Y⋅

X
z
---

n!

n n 1–( ) n 2–( )…2 1⋅⋅ ⋅ n 1≥
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Vector and matrix subscript , 

  

Keystroke [ Toolbar Button

Description If v is a vector, vn returns the nth element of v. 
If M  is a matrix, M i, j returns the element in row i and column j of M .

Complex conjugate  

Keystroke ”

Description If X is a complex number, reverses the sign of the imaginary part of X.

Absolute value  

Keystroke | Toolbar Button

Description If z is a real or complex number, |z| returns the absolute value (or modulus or magnitude)

 of z.

If v is real or complex vector, |v| returns the magnitude (or Euclidean norm or length)  
v. If all elements in v are real, this definition is equivalent to  .

If M  is a real or complex square matrix, |M | returns the determinant of M .

Square root  

Keystroke \ Toolbar Button

Description Returns the positive square root for positive z; principal value for negative or complex z.

nth root  

Keystroke [Ctrl]\ Toolbar Button

Description Returns the positive nth root for positive z; negative nth root for negative z and odd n; principal 
value otherwise. n must be an integer, . 

See also Exponentiation, Square root

Comments This operator gives the same values as the Exponentiation operator except when z < 0 and n is 
an odd integer and  (by special convention).

v
n

M
i j,

X

x

Re z( )2 Im z( )2+

v v⋅
v v⋅

z

zn

n 1≥

n 3≥
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Exponentiation
Keystroke ^ Toolbar Button

Scalar case
Description Returns the principal value of z raised to the power w, where z and w are real or complex numbers.

See also nth root

Comments The principal value is given by the formula . In the special case z < 0 and 
w = 1/n, where n is an odd integer and , the principal value has a nonzero imaginary p
Hence, in this special case, Exponentiation does not give the same value as the nth root operator 
(by convention).

Matrix case
Description If M is a real or complex square matrix and is an integer, returns the nth power of 

M  (using iterated matrix multiplication). Under the same conditions,  is the inverse of 
(assuming additionally that M is nonsingular).

Algorithm LU decomposition used for matrix inversion (Press et al., 1992)

Equals c =  

Keystroke = Toolbar Button

Description Returns numerical value of c if c is: a variable previously defined in the worksheet; a built-in
variable; a globally-defined variable; or a function of several such variables. Appears as a
ordinary = on the screen. Not used for symbolic evaluation.

Definition z : = c ,   f(x,y,z,...) : = expr  

Keystroke : Toolbar Button

Description Gives z the numerical value c from that point onward throughout the worksheet. Gives a functi
f(x,y,z,...) the meaning prescribed by the expression expr  from that point onward throughout the
worksheet. expr need not involve x, y, z, ... but it usually does; it may involve other built-in or 
user-defined functions. 

See also Definition (under Evaluation and Boolean Operators) for example.

zw

z w π i w⋅ ⋅( )exp⋅
n 3≥

n 0≥ M n

M n– M n
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Matrix Operators
To access a matrix operator:

• type its keystroke, or 

• choose the operator from the Matrix toolbar:

Refer to “Accessing Operators” on page 135 for more information on how to access a too

Insert matrix

Keystroke [Ctrl]M Toolbar Button

Description Creates a vector or matrix of specified dimensions. 

Vector and matrix subscript , 

  

Keystroke [ Toolbar Button

Description If v is a vector, vn returns the nth element of v. 
If M  is a matrix, M i, j returns the element in row i and column j of M .

Dot product 
Keystroke * Toolbar Button

Description Returns the dot product (scalar or inner product) of two n-dimensional real or complex vectors
u and v.

Cross product 

Keystroke [Ctrl]8 Toolbar Button

Description Returns the cross product (vector product) of two 3-dimensional real or complex vectors u and v.

v
n

M
i j,

u v⋅

u v×
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Vector sum   

Keystroke [Ctrl]4 Toolbar Button

Description Returns the sum (a scalar) of all elements of a real or complex vector v. (No range variable or 
vector subscripts are needed.)

Matrix Inverse   

Keystroke ^-1 Toolbar Button

Description Returns the multiplicative inverse of a real or complex nonsingular square matrix M .

Magnitude and Determinant    

Keystroke | Toolbar Button

Description If z is a real or complex number, |z| returns the absolute value (or modulus or magnitude)
 of z.

If v is real or complex vector, returns the magnitude (or Euclidean norm or length)  ov. 
If all elements in v are real, this definition is equivalent to .

If M  is a real or complex square matrix, returns the determinant of M .

Algorithm LU decomposition (Press et al., 1992)

Matrix superscript  

Keystroke [Ctrl]6 Toolbar Button

Description Extracts column n (a vector) from matrix M .

Matrix transpose 
Keystroke [Ctrl]1 Toolbar Button

Description If M  is a vector or matrix, returns a matrix whose rows are the columns of M  and whose columns 
are the rows of M .

Vectorize  

Keystroke [Ctrl]- Toolbar Button

Description Forces operations in expression  X to take place element by element. All vectors or matrices
X must be the same size.

Σv

x

Re z( )2 Im z( )2+

v v⋅
v v⋅

M n〈 〉

M T

X
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Comments Mathcad's vectorize operator allows parallel operations to be performed efficiently on each
element of a vector or matrix. For example, to define a matrix P by multiplying corresponding 
elements of the matrices M  and N, you could write  where i and j are range 
variables. (This is not matrix multiplication, but rather multiplication element by element.) 
faster, however, to define P using vectorize:

• Select the whole expression by clicking inside 
and pressing [Space ] until the right-hand side 
is held between the editing lines. 

• Press [Ctrl ]– to apply the vectorize operator. 
Mathcad puts an arrow over the top of the 
selected expression.

Extending ordinary scalar multiplication to matrices in this fashion, element by element, is
referred to as “vectorizing” an expression. 

Here are some properties of the vectorize operator: 

• The vectorize operator changes the meaning of functions and operators but not consta
variables.

• Operations between an array and a scalar are performed by applying the scalar to each e
of the array. For example, if v is a vector and n is a scalar, applying the vectorize operator
to  returns a vector whose elements are the nth powers of the elements of v.

• You cannot use any of the following matrix operations under a vectorize operator: dot
product, matrix multiplication, matrix powers, matrix inverse, determinant, or magnitud
a vector. The vectorize operator will transform these operations into element-by-elem
scalar multiplication, exponentiation, or absolute value, as appropriate.

• The vectorize operator has no effect on operators and functions that require vectors or 
matrices: transpose, cross product, sum of vector elements, and functions like mean. These 
operators and functions have no scalar meaning.

Picture
Keystroke [Ctrl]T Toolbar Button

Description Displays a matrix M  as a grayscale image. Each element of M corresponds to a pixel. The value
of an element determines the shade of gray associated with the corresponding pixel. Each e
of M is an integer between 0 (black) and 255 (white).

Pi j, M i j, N i j,⋅=

vn
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Calculus Operators
To access a calculus operator:

• type its keystroke, or 

• choose the operator from the Calculus toolbar:

Refer to “Accessing Operators” on page 135 for more information on how to access a too

Summation  

Keystroke [Ctrl][Shift]4  Toolbar Button

Description Performs iterated addition of X over . X can be any expression; it need no
involve i but it usually does. m and n must be integers. If   or , the evaluation
must be performed symbolically. 

Example

See also Range sum

Comments To evaluate multiple summations, place another summation in the final placeholder of the
summation, as illustrated in the example.

X
i m=

n
∑

i m m 1 … n, ,+,=
m ∞–= n ∞=
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Product  

Keystroke [Ctrl][Shift]3  Toolbar Button

Description Performs iterated multiplication of X over .  X can be any expression; it need
not involve i but it usually does.  If   or , the evaluation must be performe
symbolically. Works similar to Summation. 

See also Range product. See Summation for an example.

Range sum

Keystroke $ Toolbar Button

Description Performs iterated addition of X over the range variable i. X can be any expression; it need not 
involve i but it usually does. 

Example

See also Summation

Comments When you use the Summation operator described earlier, the summation must be carried o
over integers and in steps of one. Mathcad provides a more general version of this operato
can use any range variable you define as an index of summation. 

The Range sum operator, unlike the  Summation operator, cannot stand alone. It requires th
existence of a range variable. However, a single range variable can be used with any num
these operators. 

To evaluate multiple summations, place another summation in the final placeholder of the
summation and use two range variables, as illustrated in the example.

X
i m=

n
∏

i m m 1 … n, ,+,=
m ∞–= n ∞=

X
i

∑
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Range product  

Keystroke # Toolbar Button

Description Performs iterated multplication of X over the range variable i. X can be any expression; it need
not involve i but it usually does. Works similar to Range sum. 

See also Product. See Range sum for an example.

Definite integral  

Keystroke & Toolbar Button

Description Returns the definite integral of f(t) over the interval . a and b must be real scalars. All 
variables in the expression f(t), except the variable of integration t, must be defined. The 
integrand, f(t), cannot return an array. , , or both are permitted.  

Examples

Example 1

X
i

∏

f t( ) td
a
b

∫

a b,[ ]

a ∞–= b ∞=
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Example 2

Comments There are some important things to remember about integration in Mathcad:

• The limits of integration must be real, but the expression to be integrated can be eithe
or complex.

• Except for the integrating variable, all variables in the integrand must have been defin
elsewhere in the worksheet.

• The integrating variable must be a single variable name. 

• If the integrating variable involves units, the upper and lower limits of integration must h
the same units.

Like all numerical methods, Mathcad's integration algorithm can have difficulty with ill-beha
integrands. If the expression to be integrated has singularities, discontinuities, or large and
fluctuations, Mathcad's solution may be inaccurate. 

In some cases, you may be able to find an exact expression for your definite integral or ev
indefinite integral (antiderivative) by using Mathcad’s symbolics.

Although the result of an integration is a single number, you can always use an integral w
range variable to obtain results for many numbers at once (as illustrated in Example 1). S
repeated evaluations may take considerable time depending on the complexity of the inte
the length of the interval, and the value of TOL.

Mathcad's numerical integration algorithm makes successive estimates of the value of the in
and returns a value when the two most recent estimates differ by less than the value of th
in variable TOL. Example 2 above shows how changing TOL affects the accuracy of integ
calculations. (This is not to be confused with the mere formatting issue of how many digit
display.)

You can change the value of the tolerance by including definitions for TOL directly in you
worksheet as shown. You can also change the tolerance by using the Built-In Variables tab
you choose Options from the Math  menu. To see the effect of changing the tolerance, choo
Calculate Document from the Math  menu to recalculate all the equations in the worksheet

If Mathcad's approximations to an integral fail to converge to an answer, Mathcad marks 
integral with an appropriate error message.
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When you change the tolerance, keep in mind the trade-off between accuracy and compu
time. If you decrease (tighten) the tolerance, Mathcad will compute integrals more accura
However, because this requires more work, Mathcad will take longer to return a result. Con
ly, if you increase (loosen) the tolerance, Mathcad will compute more quickly, but the ans
will be less accurate.

You can also use Mathcad to evaluate double or multiple integrals. To set up a double int
press the ampersand key, [&] , twice. Fill in the integrand, the limits, and the integrating variab
for each integral. Keep in mind that double integrals take much longer to converge to an a
than single integrals. Wherever possible, use an equivalent single integral in place of a do
integral.

Because certain numerical integration methods work best on certain kinds of integrals, Ma
has an AutoSelect feature for integration. Depending on the kind of integral you are evalua
Mathcad automatically chooses the most appropriate integration method to use. Using Au
lect, Mathcad examines the integral and evaluates it using one of the following methods:

• Romberg (Romberg trapezoidal approximation with Richard extrapolation − equal intervals)

• Adaptive (if the values of f(x) vary significantly over the interval − unequal intervals) 

• Infinite Limit (if ,  or both) 

• Singular Endpoint (if f(a) and/or f(b) is undefined)

In Mathcad Professional, if you want to evaluate an integral using a method other than th
chosen during the AutoSelect process, turn off AutoSelect and choose another method. To

1. Type the integral and allow AutoSelect to return a result.

2. Click on the integral with the right mouse button.

3. Click on the method you want to use.

The integral is automatically re-evaluated using the method you clicked and is re-evaluate
way from then on, unless you specify another method or AutoSelect later.

Algorithm Romberg, Kahan transform, QAGS, Clenshaw-Curtis, Gauss-Kronrod formulas (Piessens 
Lorczak)

Indefinite integral

Keystroke [Ctrl]i Toolbar Button

Description Returns the indefinite integral (that is, an antiderivative) of f(t). Must be performed  symbolically. 
The integrand, f(t), cannot return an array.

Derivative  

Keystroke ? Toolbar Button

Description Returns the derivative of f(t) evaluated at t. All variables in the expression f(t) must be defined. 
The variable t must be a scalar value. The function f(t) must return a scalar.

a ∞–= b ∞=

f t( ) td∫

td
d f t( )
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Example

Comments With Mathcad's derivative algorithm, you can expect the first derivative to be accurate to w
7 or 8 significant digits, provided that the value at which you evaluate the derivative is not
close to a singularity of the function. The accuracy of this algorithm tends to decrease by 
significant digit for each increase in the order of the derivative (see nth derivative operator).

The result of differentiating is not a function, but a single number: the computed derivativ
the indicated value of the differentiation variable. In the previous example, the derivative o
is not the expression  but  evaluated at . If you want the expression , y
will need to use either live or menu symbolics.  

Although differentiation returns just one number, you can still define one function as the 

derivative of another. For example: . Evaluating f(x) will return the numerically 

computed derivative of g(x) at x. You can use this technique to evaluate the derivative of a 
function at many points via range variables.

Algorithm Modified Ridder’s method (Press et al., 1992; Lorczak)

nth derivative

Keystroke [Ctrl]? Toolbar Button

Description Returns the nth derivative of f(t) evaluated at t. All variables in f(t) must be defined. The variable
t must be a scalar value. The function f(t) must return a scalar. n must be an integer between 0 
and 5 for numerical evaluation or a positive integer for symbolic evaluation.

Comments For , this operator gives the same answer as the Derivative operator. For , it si
returns the value of the function itself.

Algorithm Modified Ridder’s method (Press et al., 1992; Lorczak)

x3

3x2 3x2 x 2= 3x2

f x( )
xd

d g x( ):=

tn

n

d

d f t( )

n 1= n 0=
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Limit  

Keystroke [Ctrl]L Toolbar Button

Description Returns the two-sided limit of f(t). Must be evaluated symbolically.

Algorithm Series expansion (Geddes and Gonnet, 1989)

Right-Hand Limit

Keystroke [Ctrl][Shift]A Toolbar Button

Description Returns the right-hand limit of f(t). Must be evaluated symbolically.

Algorithm Series expansion (Geddes and Gonnet, 1989)

Left-Hand Limit  

Keystroke [Ctrl][Shift]B Toolbar Button

Description Returns the left-hand limit of f(t). Must be evaluated symbolically.

Algorithm Series expansion (Geddes and Gonnet, 1989)

f t( )
t a→
lim

f t( )
t a+→

lim

f t( )
t a-→

lim
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Evaluation and Boolean Operators
To access an Evaluation or Boolean operator:

• type its keystroke, or 

• choose the operator from the Evaluation and Boolean toolbar:

Refer to “Accessing Operators” on page 135 for more information on how to access a too

Greater than ,   

Keystroke > Toolbar Button

Description For real scalars x and y, returns 1 if , 0 otherwise. 
For string expressions S1 and S2, returns 1 if S1 strictly follows S2 in ASCII order, 0 otherwise.

Less than , 

Keystroke < Toolbar Button

Description For real scalars x and y, returns 1 if , 0 otherwise. 
For string expressions S1 and S2, returns 1 if S1 strictly precedes S2 in ASCII order, 0 otherwise.

Greater than or equal to  ,  

Keystroke [Ctrl]) Toolbar Button

Description For real scalars x and y, returns 1 if , 0 otherwise. 
For string expressions S1 and S2, returns 1 if S1 follows S2 in ASCII order, 0 otherwise.

Less than or equal to  ,  

Keystroke [Ctrl]( Toolbar Button

Description For real scalars x and y, returns 1 if , 0 otherwise. 
For string expressions S1 and S2, returns 1 if S1 precedes S2 in ASCII order, 0 otherwise.

x y> S1 S2>

x y>

x y< S1 S2<

x y<

x y≥ S1 S2≥

x y≥

x y≤ S1 S2≤

x y≤
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Not equal to ,  

Keystroke [Ctrl]3 Toolbar Button

Description For scalars z and w, returns 1 if , 0 otherwise.
For string expressions S1 and S2, returns 1 if S1 is not character by character identical to S2, 0 
otherwise.

Bold Equals z = w  

Keystroke [Ctrl]= Toolbar Button

Description Returns 1 if , 0 otherwise (also known as Boolean equals). Appears as a bold = on
screen.  Also used when typing constraint equations within solve blocks or when typing equa
to be solved symbolically.

Equals c =  

Keystroke = Toolbar Button

Description Returns numerical value of c if c is: a variable previously defined in the worksheet; a built-in
variable; a globally-defined variable; or a function of several such variables. Appears as a
ordinary = on the screen. Not used for symbolic evaluation.

Definition z : = c ,   f(x,y,z,...) : = expr  

Keystroke : Toolbar Button

Description Gives z the numerical value c from that point onward throughout the worksheet. Gives a functi
f(x,y,z,...) the meaning prescribed by the expression expr  from that point onward throughout the
worksheet. expr need not involve x, y, z, ... but it usually does; it may involve other built-in or 
user-defined functions. 

Examples

z w≠ S1 S2≠

z w≠

z w=
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Comments You can define arrays in the same way as scalars, with the array name A on the left side of a :=, 
and a corresponding array of values to the right.

You can likewise use arrays to define several variables at once, as the previous example 
The left side of a simultaneous definition is an array whose elements are either names or
subscripted variable names. The right side must be an array of values having the same n
of rows and columns as the left side. Mathcad defines each variable on the left side with the
of the array in the corresponding position on the right side. Elements on the right side are
evaluated before assigning any of them to the left side. Because of this, nothing on the righ
of an expression can depend on what is on the left side. You also cannot have a variable 
more than once on the left side.

When you define a function, Mathcad does not try to evaluate it until you use it later on in
worksheet. If there is an error, the use of the function is marked in error, even though the
problem may be in the definition of the function itself. For example,  if  f(x) := 1/x and you attempt 
to evaluate f(0), the error flag occurs not at the definition of f(x) but when Mathcad encounters
f(0) for the first time. 

Global Definition ,  

Keystroke ~ Toolbar Button

Description Gives z the numerical value c and this holds throughout the worksheet (regardless of where 
global definition is positioned). Likewise, gives a function f(x,y,z,...) the meaning prescribed by
the expression expr throughout the worksheet. expr need not involve x, y, z, ... but it usually does;  
it may involve other built-in or user-defined functions. 

Comments You can globally define arrays in the same way as scalars, with the array name A on the left side 
of a  ≡, and a corresponding array of values to the right.

This is the algorithm that Mathcad uses to evaluate all definitions, global and otherwise: 

• First, Mathcad takes one pass through the entire worksheet from top to bottom. During
first pass, Mathcad evaluates global definitions only.

z c≡ f x y z …, , ,( ) expr≡
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• Mathcad then makes a second pass through the worksheet from top to bottom. This t
Mathcad evaluates all definitions made with := as well as all equations containing ≡.

Although global definitions are evaluated before any local definitions, Mathcad evaluates g
definitions the same way it evaluates local definitions: top to bottom and left to right. This m
that whenever you use a variable to the right of a ≡:

• that variable must also have been defined with a ≡, and

• the variable must have been defined above the place where you are trying to use it.

Otherwise, the variable is marked in red to indicate that it is undefined.

It is good practice to allow only one definition for each global variable. Although you can de
a variable with two different global definitions or with one global and one local definition, t
is never necessary and usually makes your worksheet difficult to understand.

Symbolic Equals
Keystroke [Ctrl]. Toolbar Button

Description Returns live symbolic “value” of c if c is a variable previously defined in the worksheet, is a 
built-in variable, is a globally-defined variable, or is a function of several such variables. 

Comments The live symbolic equals sign is analogous to the numerical equals sign “=” and is capabl
giving expressions. You can use it, for example, to symbolically simplify or factor algebra
expressions, or to symbolically evaluate derivatives, integrals and limits. Note that “→” applies 
only to an entire expression (unlike menu symbolics).

Prefix f  x (Professional)

Keystroke NONE Toolbar Button

Description Using the prefix custom operator, f x returns the value f(x), where f is either a built-in or user-
defined function and x is a real or complex number. 

c →
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Example 1: Defining your own operators

Example 2: Displaying an operator as a function and a function as an operator 

Comments In Example 1, the symbol “¬” comes from the Symbol font. First define a function “¬(x)” as 
illustrated, then click the prefix button on the Evaluation toolbar to use prefix notation. For p
notation, type the name of the operator in the left placeholder and the operand in the righ
placeholder.

Many publishers prefer to omit parentheses around the arguments to certain functions (sin x rather 
than ). You can do the same thing by treating the sin function as an operator with one 
operand, as in Example 2. 

x( )sin
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Postfix x  f (Professional)

Keystroke NONE Toolbar Button

Description Using the postfix custom operator, x f returns the value f(x), where f is either a built-in or user-
defined function and x is a real or complex number. 

Comments In Example 1, on page 155, the symbol “°” comes from the Symbol font. First define a function
“ °(x)” as illustrated, then click the postfix button on the Evaluation toolbar to use postfix nota
For postfix notation, type the name of the operator in the right placeholder and the operan
the left placeholder.

Infix x f  y (Professional)

Keystroke NONE Toolbar Button

Description Using the infix custom operator, x f y returns the value f(x,y), where f is either a built-in or user-
defined function and x, y are real or complex numbers. 

Comments In Example 1, on page 155, the symbol “≈” comes from the Symbol font. First define a binary
function “≈(x,y)” as illustrated, then click the infix button on the Evaluation toolbar to use in
notation. For infix notation, type the name of the operator in the middle placeholder and th
operands in the left and right placeholders.

Likewise, in Example 2, on page 155, the binary function “÷(x,y)” is defined and then displayed 
in the more conventional manner:  “x÷y”. Functions and operators are fundamentally the sam
Although notation like  “÷(x,y)”  is unconventional, use it if you prefer.

Treefix x  f  y (Professional)

Keystroke NONE Toolbar Button

Description Using the treefix custom operator, x  f y returns the value f(x,y), where f is either a built-in or user-
defined function and x and y are real or complex numbers. 

Comments In Example 1, on page 155, the symbol “÷” comes from the Symbol font. First define a binary
function “÷(x,y)” as illustrated, then click the treefix button on the Evaluation toolbar to use
treefix notation. For treefix notation, type the name of the operator in the middle placeholde
the operands in the left and right placeholders.
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Programming Operators
To access a Programming operator:

• type its keystroke, or 

• choose the operator from the Programming toolbar:

Refer to “Accessing Operators” on page 135 for more information on how to access a too

Special Note: these operators are valid only within a Mathcad programming structure. 

Local Definition  (Professional) 

Keystroke { Toolbar Button

Description Gives w the numerical value of the function f(a,b,c,...) within a program. 
Outside the program, w remains undefined. 

Add Line  (Professional)

Keystroke ] Toolbar Button

Description Inserts a line in a program. When you insert the Add Line operator the first time, a program is
created (a vertical bar with two placeholders). If you select either of these placeholders and
the Add Line operator again, more placeholders are created. 

Conditional Statement  (Professional)

Keystroke } Toolbar Button

Description Within a program, permits evaluation of a statement only when a specified condition is met.
must insert this operator using its keystroke or toolbar button. (Conditional if is not the same as 
the built-in if function. Do not just type the word “if”.) 

w f a b c …, , ,( )←
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Otherwise Statement  (Professional) 

Keystroke NONE Toolbar Button

Description Within a program, used in conjunction with the if statement to exhaust possibilities not yet 
covered. You must insert this operator using its toolbar button. (Do not just type the word
“otherwise”.) 

For Loop  (Professional)

Keystroke NONE Toolbar Button

Description Within a program, permits evaluation of a sequence of statements a specified number of 
The right hand placeholder usually contains a range variable. You must insert this operator
its toolbar button. (Do not just type the word “for”.) 

While Loop  (Professional)

Keystroke NONE Toolbar Button

Description Within a program, permits evaluation of a sequence of statements until a specified condit
met. The right hand placeholder usually contains a Boolean expression. You must insert 
operator using its toolbar button. (Do not just type the word “while”.)

Break Statement (Professional)

Keystroke NONE Toolbar Button

Description Within a for or while loop, halts loop execution. Usually used in conjunction with an if statement, 
that is, halting occurs if a specified condition occurs. Execution moves to the next statem
outside the loop. You must insert this operator using its toolbar button. (Do not just type the 
“break”.) 

See also continue and return

Continue Statement (Professional)

Keystroke NONE Toolbar Button

Description Within a for or while loop, halts loop execution. Usually used in conjunction with an if statement, 
that is, halting occurs if a specified condition occurs. Execution moves to the beginning o
next iteration of the current loop. You must insert this operator using its toolbar button. (Do
just type the word “continue”.) 

See also break and return
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Return Statement (Professional)

Keystroke NONE Toolbar Button

Description Within a program, halts program execution. Usually used in conjunction with an if statement, 
that is, halting occurs if a specified condition occurs. Also, within a for or while loop, halts loop 
execution; execution in this case moves to the next statement outside the loop. You must
this operator using its toolbar button. (Do not just type the word "return".) 

See also break and continue

Comments The break function does the same as return, but gives the value only of the last expression 
evaluated before break is called. Therefore return is more flexible, because it allows you to 
interrupt the program and return particular values other than the default value last compu

On Error Statement (Professional) 

Keystroke NONE Toolbar Button

Description Within a program, permits computation of an alternative expression when an arbitrary nume
error flag is raised. You must insert this operator using its toolbar button. (Do not just type
phrase "on error".) 

Comments on error executes the right-hand argument first.  If no error occurs, it returns the result of 
right argument.  If an error occurs, then the error is cleared and the left argument is return.

on error is a general purpose error trap. It is more powerful than using the return statement, 
coupled with some specific test, to deal with inputs that give rise to numerical error.
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